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KATA PENGANTAR

Puji syukur kami panjatkan ke hadirat Tuhan Yang Maha Esa karena
berkat rahmat dan karunia-Nya, modul praktikum ini dapat kami selesaikan
dengan baik. Modul ini kami susun dengan tujuan membantu siapa saja yang
berminat pada bidang Manajemen Operasional, terutama bagi para mahasiswa/i

yang mengikuti praktikum di Laboratorium Manajemen Menengah.

Untuk memudahkan penyelesaian masalah yang ada, modul ini juga
dilengkapi dengan cara penggunaan aplikasi WINQSB sebagai software yang
digunakan untuk mengurangi kesalahan penghitungan secara manual dan

mempertinggi keakuratan dalam memecahkan masalah yang ada.

Dalam kesempatan ini, tim penyusun ingin mengucapkan terima kasih
kepada kedua orang tua kami, staff Laboratorium Manajemen Menengah
Universitas Gunadarma, juga para asisten senior, serta rekan-rekan asisten

lainnya yang telah memberikan bantuan dalam penyusunan modul ini.

Akhir kata, penyusun menyadari terdapat banyak kekurangan dalam
modul ini. Oleh karena itu, kami memohon kritik dan saran yang bersifat
konstruktif demi perbaikan dalam penyusunan modul yang akan datang. Semoga

modul ini dapat membantu semua pihak yang membacanya.

Depok-Kalimalang, September 2023

Tim Penyusun Litbang

2|ManajemenOperasional



DAFTAR ISl

KATA PENGANTAR ..ottt 2
BAB | MANUFACTURING RESOURCE PLANNING........ccccocvriniiirieniens 5
1.1 Perencanaan Kebutuhan Material.............ccooeiiiiininiiiniese e 7
1.2 LOU SIZING ctitiitieieeiee et 7
BAB || FORECASTING (PERAMALAN)......ccioiiiiiiieiee e 16
2.1 Kegunaan dan Peranan Peramalan ............cccccocoeieeniiieiie v 16
2.2 Metode Peramalan..........cccoiverveieniiene et 18
2.3 Kesalahan Peramalan ..........cccocvoiiiiiiiie i 20
BAB 111 ANALISIS JARINGAN CPM TANPA PERCEPATAN................ 33
3.1 Keuntungan Analisis JArinQan..........ccccveveiieieeiieiie e 35
3.2 SIMbOI-SIMBOI JArNQAN ..o 36
3.2 Istilah-istilah Lain Dalam NEtWOrK ..........ccccovveieiieiieirse e 36
3.3 Beberapa Hal yang Perlu Diperhatikan Dalam Analisis jaringan................ 37
3.4 DUMMY ACHVITIES ...ttt 38
3.5 Jalur KritiS (CRITICAL PATH) ..cceeiieee et 39
BAB IV CPM (CRITICAL PATH METHOD) DENGAN PERCEPATAN.... 49
4.1 Informasi yang dibUtuhKan ............cccoovoiiiiiiece e 50
4.2 Biaya yang diperhitungkan ...........cccocveviiviiiieiecie e 51

3|ManajemenOperasional



Buku Seri Praktikum

Bab 1

MANUFACTURING
RESOURCE PLANNING

'wﬂ

=\ ,/

) UNIVERSITAS GUNADA




BAB |
MANUFACTURING RESOURCE PLANNING

Deskripsi Modul

Untuk menjamin kebutuhan-kebutuhan konsumen akan produk yang diproduksi
oleh perusahaan, maka perusahaan perlu mengontrol persediaan yang ada agar
siap menjawab kebutuhan konsumen setiap saat tepat pada waktunya. Oleh
karena itu, perusahaan hendaklah menerapkan suatu sistem atau metode yang
efektif guna merespon masalah-masalah yang ada. Salah satu cara untuk
mengendalikan persediaan adalah dengan metode Material Requirement
Planning (MRP). MRP merupakan teknik pendekatan yang bertujuan
meningkatkan produktivitas perusahaan dengan cara menjadwalkan kebutuhan
akan material dan komponen untuk membantu perusahaan dalam mengatasi
kebutuhan minimum dari komponen-komponen yang kebutuhannya dependen dan

menjamin tercapainya produksi akhir.

Tujuan Modul

Setelah menyelesaikan praktikum pada modul ini, praktikan akan memahami:

1. Pengendalian persediaan dengan menggunakan metode MRP (metode Lot for
Lot dan Economic Order Quantity (EOQ)).

2. Memahami perhitungan menggunakan metode pada MRP.

Isi

Pembelajaran : Menganalisis pengendalian persediaan suatu perusahaan.
Latihan 1 : Menghitung pengendalian persediaan dengan menggunakan metode
Lot for Lot dan Economic Order Quantity (EOQ).
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Apa itu MRP?

Material Requirement Planning (MRP) adalah suatu teknik yang digunakan untuk
perencanaan dan pengendalian item barang (komponen) yang tergantung
(dependent) pada item ditingkat (level) yang lebih tinggi. MRP pertama kali
ditemukan oleh Joseph Orlicky dari J.I. Case Company pada sekitar tahun 1960.
MRP selalu berkembang sesuai dengan tuntutan perkembangan teknologi dan
tuntutan terhadap sistem perusahaan. Sampai saat ini, perkembangan MRP
terjadi sampai dengan 4 (empat) kali dan tidak tertutup untuk masa yang akan

datang MRP akan berkembang terus.

Keempat perkembangan MRP tersebut adalah :

1. Material Requirement Planning (MRP) adalah suatu teknik atau kumpulan
prosedur yang sistematis dalam penentuan kuantitas serta waktu dalam proses
pengendalian bahan terhadap komponen-komponen permintaan yang saling
bergantung (Dependent Demand Item).

2. Material Requirement Planning Il (MRP II) adalah perluasan dari MRP, lebih
dari sekedar proses penentuan kebutuhan material. Fenomena ini melahirkan
konsep baru yang disebut Perencanaan Sumber Daya Manufaktur (MRP II).

3. Material Requirement Planning Il (MRP I1l) adalah perluasan MRP dalam
tingkat akurasi peramalan, permintaan, dan penggunaan secara tepat dan baik
peramalan permintaan (Forecast Demand), sehingga dapat merubah Master
Production Schedule (MPS).

4. Material Requirement Planning 9000 (MRP 9000) adalah perluasan MRP
yang sudah merupakan tawaran yang benar-benar lengkap dan terintegrasi
dengan sistem management manufacturing, termasuk juga inventory,penjualan,

perencanaan, pembuatan, dan pembelian menggunakan buku besar.
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1.1 Perencanaan Kebutuhan Material

Logika Perencanaan Kebutuhan Material

1. Netting

Proses mencari jumlah kebutuhan bersih dari komponen yang didapat dengan
mengurangi kebutuhan kotor dengan inventory yang ada dan penerimaan yang
terjadi.

2. Lot Sizing

Proses mendapatkan jumlah ukuran lot untuk memenuhi Net Requirement
(NR).

3. Offsetting

Proses menetapkan waktu kapan suatu order harus dilakukan (berhubungan
dengan Lead Time).

4. Explosion

Proses menghitung kebutuhan komponen-komponen yang mempunyai level

dibawahnya (berikutnya).

1.2 Lot Sizing
Suatu metode perhitungan yang digunakan untuk menentukan jumlah order suatu

material, sehingga biaya inventory dapat diminimumkan.

Penentuan Lot Sizing ini dipengaruhi oleh dua komponen biaya utama:

» Order Cost (kalau pemesanan ke supplier) dan Set Up Cost (kalau
diproduksi sendiri)
> Holding Cost (biaya simpan)
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Beberapa teknik (metode) Lot Sizing :
1. Lot for Lot

2. Economic Order Quantity (EOQ)
3. Period Order Quantity (POQ)

4. Part Period Balancing (PPB)

5. Least Unit Cost (LUC)

6

. Minimum Cost per Period atau Algoritma Silver Meal

A. Lot For Lot

Teknik penetapan ukuran lot dengan ini dilakukan atas dasar pesanan
diskrit. Di samping itu, teknik ini merupakan cara paling sederhana dari
semua teknik ukuran lot yang ada. Teknik ini hampir selalu melakukan
perhitungan kembali terutama sekali apabila terjadi perubahan pada kebutuhan
bersih. Penggunaan teknik ini bertujuan untuk meminimumkan ongkos simpan,
sehingga dengan teknik ini ongkos simpan menjadi nol.

Oleh karena itu, sering sekali digunakan untuk item-item yang mempunyai
harga/unit sangat mahal. Juga apabila dilihat dari pola kebutuhan yang
mempunyai sifat diskontinu atau tidak teratur, maka teknik L4L ini memiliki
kemampuan yang baik. Di samping itu, teknik ini sering digunakan pada sistem
produksi manufaktur yang mempunyai sifat “set- up” permanen pada proses

produksinya.

Biaya Pesan Per Pemesanan (SC) = Banyaknya Melakukan

Pemesanan x Biaya Pesan Setiap Kali Pesan

B. Economic Order Quantity (EOQ)

Penetapan ukuran lot dengan teknik ini hampir tidak pernah dilupakan
dalam lingkungan MRP karena teknik ini sangat populer dalam sistem
persediaan tradisional. Dalam teknik ini pun besarnya ukuran lot adalah tetap.
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Namun, perhitungannya sudah mencakup semua biaya pesan serta biaya simpan.
Perumusan yang akan dipakai dalam teknik ini adalah sebagai berikut:

Total Net Requirement

X 52
Jjumlah minggu _ [2XDxSC
E0Q = e

Keterangan:

D = Permintaan

SC =Set Up Cost
HC = Holding Cost

CONTOH SOAL
Perusahaan Manufaktur Jeans hendak menentukan besarnya lot, berikut adalah
informasi yang dapat diperoleh:

Harga per komponen (Cost/component) Rp 10/unit

Biaya pesan per pemesanan (Set Up Cost/Order) Rp 30/pesan

Biaya simpan per minggu (Holding Cost/Week) 10 %

Biaya simpan per tahun (Holding Cost/Year) 0,4%

Week 1 2 3 4 5 6 7 8 9
Net Requirement 40 | 50 | 55 | 60 | 70 | 65 | 80 | 50 | 85

Tentukan metode Lot Sizing bila alternatif teknik Lot Sizing yang akan
digunakan adalah:
1. Lot For Lot (L4L).

2. Economic Order Quantity (EOQ).
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PENYELESAIAN
MANUFAKTUR JEANS
1. Lot For Lot (L4L)

Biaya Simpan (HC) = Persediaan Akhir (End Inventory) X
Biaya Simpan PerMinggu (Holding Cost/week)

Biaya Simpan Per Minggu = 10% x 10

=1

Biaya Simpan (HC) =0x 1
=0

Biaya Pesan Per Pemesanan (SC) = Banyaknya melakukan
Pemesanan X Biaya Pesan Setiap Kali Pesan

Pada minggu pertama hingga minggu ke-9 Product Quantity samadengan Net

Requirement, jadi pemesanan hanya dilakukan 1 Kali.

Minggu 1 Minggu 6

Biaya Pesan Pemesanan (SC) Biaya Pesan Pemesanan (SC)
=1X30 =1X30

=30 =30

Minggu 2 Minggu 7

Biaya Pesan Pemesanan (SC) Biaya Pesan Pemesanan (SC)
=1X30 =1X30

=30 =30

Minggu 3 Minggu 8

Biaya Pesan Pemesanan (SC) Biaya Pesan Pemesanan (SC)
=1X30 =1X30

=30 =30

Minggu 4 Minggu 9

Biaya Pesan Pemesanan (SC) Biaya Pesan Pemesanan (SC)
=1X30 =1X30

=30 =30

Minggu 5

Biaya Pesan Pemesanan (SC)

=1X30

=30
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Maka, Skedul MRP dengan Metode L4L adalah sebagai berikut:

Net Product _ Total
Week | Requirement | Quantity End |Holding Cost Set Up Inventory
(NR) (Pq)  [Inventory (HC)  |Cost(SC)| cost
(TIC)
1. 40 40 0 0 30 7) 30
2. 50 50 0 0 04 6
3. 55 55 0 0 30— 90
4. 60 60 0 0 30~ > 120
5. 70 70 0 0 30 ;3 150
6. 65 65 0 0 30 I;? 180
7. 80 80 0 0 30 ;? 210
8. 50 50 0 0 30/' 240
9. 85 85 0 0 30 | 270

Hasil perhitungan berdasarkan tabel menunjukkan bila menggunakan metode

L4L, Total Inventory Cost untuk 9 minggu sebesar 270.

2. Economic Order Quantity (EOQ)
e Permintaan tahunan berdasarkan kebutuhan 9 minggu

_ Total Net Requirement

2XDXSC
HC

D = (22) x 52 = 3.206,67 unit E0Q = \/@
__ (192.400,2
o 2,08

= 304,13 = 304

jumlah minggu EOQ
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Biaya pesan per pemesanan (SC) = 30
Biaya Simpan Tahunan = 0,4% x 10 x 52 = 2,08
Berdasarkan hasil perhitungan EOQ diperoleh 304, sehingga pemesanan pertama

kali sebanyak 304 unit.

Selanjutnya skedul pemesanan MRP dengan Lot Sizing EOQ adalah sebagai
berikut :

Net Product End Holding | Set Up Total
Week |Requirement| Quantity | Inventory | Cost (HC) |Cost (SC)| Inventory
(NR) (PQ) Cost (TIC)
1 40 304 264 10,56 30 40,56 *
2 50 0 214 8,56 0 49,12
3 55 0 159 6,36 0 55,48
4 60 0 99 3,96 0 59,44
5 70 0 29 1,16 0 60,6
6 65 304 268 10,72 30 101,32**
7 80 0 188 7,52 0 108,84
8 50 0 138 5,52 0 114,36
9 85 0 53 2,12 0 116,48
Minggu 1 Minggu 6
HC = 264 x 0,4% x 10 = 10,56 HC = 268 x 0,4% x 10 = 10,72
Minggu 2 Minggu 7
HC =214 x 0,4% x 10 = 8,56 HC =188 x 0,4% x 10 = 7,52
Minggu 3 Minggu 8
HC =159 x 0,4% x 10 = 6,36 HC =138 x 0,4% x 10 = 5,52
Minggu 4 Minggu 9
HC =99 x 0,4% x 10 = 3,96 HC =53 x 0,4% x 10 = 2,12
Minggu 5
HC =29x0,4% x 10 =1,16
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*Total Inventory Cost (TIC) Minggu ke-1 = HC + SC = 10,56 + 30 = 40,56
** Total Inventory Cost (TIC) Minggu ke-6 = TIC minggu ke-5 + HC + SC
= 60,6 + 10,72 +30 = 101,32

Berdasarkan tabel diatas dapat disimpulkan bahwa bila digunakan metode
EOQ, Total Inventory Cost (TIC) dihasilkan sebesar 116,48.

Soal Uji Kemampuan
1. PT Jaya Wijaya Nusantara ingin menentukan besarnya lot, berikut adalah
informasi yang diperoleh:
Harga per komponen (Cost/Component) Rp 20/unit
Biaya pesan per pemesanan (Set Up Cost/Order) Rp 20/pesan
Biaya simpan per minggu (Holding Cost/Week) 10%
Biaya simpan per tahun (Holding Cost/Year) 0.2%

Week 1 2 3 4 5 6 7 8 9

Net Requirement | 20 25 30 35 40 45 50 55 60

Tentukan metode Lot Sizing bila alternatif teknik Lot Sizing yang akan
digunakan adalah..

A. Lot for Lot (L4L)

B. Economic Order Quantity (EOQ)

2. Perusahaan Manufaktur Hybe Jaya hendak menentukan besarnya lot, berikut
adalah informasi yang diperoleh:
Harga per komponen (Cost/Component) Rp 10/unit
Biaya pesan per pemesanan (Set Up Cost/Order) Rp 22/pesan
Biaya simpan per minggu (Holding Cost/Week) 12%
Biaya simpan per tahun (Holding Cost/Year) 0.3%
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Week 1 2 3 4 5 6 7
Net Requirement 40 44 30 60 55 70 74

Tentukan metode Lot Sizing bila alternatif teknik Lot Sizing yang akan
digunakan adalah..

A. Lot for Lot (L4L)

B. Economic Order Quantity (EOQ)

3. Perusahaan Manufaktur elektronik hendak menentukan besarnya lot, berikut
adalah informasi yang diperoleh:
Harga per komponen (Cost/Component) Rp 10/unit
Biaya pesan per pemesanan (Set Up Cost/Order) Rp 40/pesan
Biaya simpan per minggu (Holding Cost/Week) 10%
Biaya simpan per tahun (Holding Cost/Year) 0.4%

Week 1 2 3 4 5 6 7
Net Requirement 22 33 44 55 66 77 88

Tentukan metode Lot Sizing bila alternatif teknik Lot Sizing yang akan
digunakan adalah..

A. Lot for Lot (L4L)

B. Economic Order Quantity (EOQ)

14| ManajemenOperasional
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BAB II
FORECASTING (PERAMALAN)

APA ITU FORECASTING ?

Forecasting diartikan sebagai seni dan ilmu untuk memperkirakan kejadian di
masa depan atau dapat juga diartikan segala aktivitas bisnis yang memperkirakan
penjualan dan penggunaan produk sehingga produk-produk itu dapat dibuat dalam
kuantitas yang tepat. Peramalan merupakan dugaan terhadap permintaan yang
akan datang berdasarkan pada beberapa variabel peramal, biasanya berdasarkan
data deret waktu historis dan menggunakan teknik-teknik peramalan yang bersifat

formal maupun informal (Gaspersz, 1998).

Metode peramalan akan membantu dalam mengadakan pendekatan analisa
terhadap tingkah laku atau pola dari data yang lalu, sehingga dapat memberikan
cara pemikiran, pengerjaan dan pemecahan yang sistematis dan pragmatis, serta
memberikan tingkat keyakinan yang lebih besar atas ketepatan hasil ramalan yang
dibuat.

2.1 Kegunaan dan Peranan Peramalan

Kegiatan peramalan merupakan bagian integral dari pengambilan keputusan
manajemen. Peramalan mengurangi ketergantungan pada hal-hal yang belum pasti
(intuitif). Peramalan memiliki sifat saling ketergantungan antar divisi atau bagian.
Kesalahan dalam proyeksi penjualan akan mempengaruhi pada ramalan anggaran,
pengeluaran operasi, arus kas, persediaan, dan sebagainya. Adapun dua hal pokok
yang harus diperhatikan dalam proses peramalan yang akurat dan bermanfaat
(Makridakis, 1999):

1. Pengumpulan data yang relevan berupa informasi yang dapat menghasilkan
peramalan yang akurat.
2. Pemilihan teknik peramalan yang tepat yang akan memanfaatkan informasi

data yang diperoleh semaksimal mungkin.
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Dalam perencanaan di suatu instansi baik itu pemerintah maupun swasta,
peramalan merupakan kebutuhan yang sangat mendasar. Di mana baik maupun
buruknya ramalan dapat mempengaruhi seluruh bagian instansi, karena waktu
tenggang untuk pengambilan keputusan dapat berkisar dari beberapa tahun.
Peramalan merupakan alat bantu yang penting dalam perencanaan yang efektif

dan efisien.

Beberapa sumber data yang dapat digunakan untuk melakukan peramalan adalah:
1. Pendapat konsumen

2. Pendapat langganan / customer

3. Catatan / pendapat distribusi

4. Catatan penjual dari perusahaan yang bersangkutan

Selain itu, kegunaan dan peranan peramalan dalam ekonomi bisnis adalah:

1. Untuk mengkaji kebijakan perusahaan yang berlaku saat ini dan di masa lalu
serta melihat sejauh mana pengaruh di masa yang akan datang.

2. Peramalan diperlukan karena adanya time-lag atau delay antara saat suatu
kebijakan perusahaan ditetapkan dengan saat implementasi.

3. Dengan adanya peramalan maka dapat dipersiapkan program dan tindakan
perusahan untuk mengantisipasi keadaan di masa yang datang, sehingga resiko
kegagalan dapat diminimumkan.

4. Peramalan merupakan dasar penyusunan bisnis pada suatu perusahaan
sehingga dapat meningkatkan efektivitas suatu rencana bisnis.

5. Peramalan juga digunakan dalam decision making karena hasil peramalan
merupakan informasi yang mendasari keputusan para manajer perusahaan

dalam berbagai tingkatan manajemen perusahaan.
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2.2 Metode Peramalan
Metode peramalan ada tiga yaitu:

1. Metode Qualitative atau metode judgemental, yaitu peramalan yang
menggunakan pusat data kualitatif, hasilnya bergantung pada orang yang
menyusunnya, seperti peramalan dengan metode delphi dan metode s-curve
past.

2. Metode Quantitative Time Series atau metode ekstrapolative, digunakan jika
datanya time series.

3. Metode Quantitative Causal atau metode eksplanatori, digunakan jika datanya

cross- sectional. Metode kausalitas ini menggunakan model regresi.

Metode peramalan data time series terdiri dari metode:
1. Naive Forecasting

2. Rata-rata Kumulatif

3. Single Moving Average (SMA)

4. Double Moving Average (DMA)

5. Single Exponential Smoothing (SES)

A. Moving Average ( Rata-Rata Bergerak/MA)

Adalah suatu metode peramalan dengan mengkombinasikan data dari
beberapa periode terbaru/terakhir. Metode ini pada dasarnya bertujuan membuat
data yang berfluktuatif menjadi data yang relatif stabil (kurang berfluktuatif)
sehingga fluktuasi dari pola data menjadi halus dan relatif merata.

Kelebihan metode ini adalah dapat diterapkan pada data jenis apapun juga
baik yang sesuai dengan kurva matematik ataupun tidak. Namun kekurangannya
adalah tidak mempunyai persamaan untuk peramalan dan sebagai gantinya
digunakan nilai rata-rata bergerak berakhir sebagai nilai ramalan untuk periode

yang akan datang.
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MA = Ypenjualan nyata pada n periode terakhir
~ Yperiode (n)yang digunakan dalam moving average

Langkah-langkah peramalan dengan menggunakan metode Moving Average :
1. Menentukan banyaknya periode untuk mendapatkan harga rata-rata

2. Membuat tabel perhitungan

3. Menemukan nilai total bergerak

4. Menemukan nilai peramalan

B. Weight Moving Average (Rata-Rata Tertimbang)

WMA adalah suatu metode peramalan yang cara perhitungannya hampir
sama dengan MA, hanya berbeda pada adanya penambahan bobot pada tiap data.
Data terakhir yang termasuk dalam periode perhitungan rata-rata diberi bobot

yang lebih besar.

WMA= W, *X)+ W,y xX, )+ W xW, )+

Dimana :

Wt = bobot terbesar

Wi-1 = bobot terbesar kedua

W1t-2 = bobot terbesar ketiga

Xt = data periode terakhir

Xt-1 = data satu periode sebelum periode terakhir

Xt-2 = data dua periode sebelum periode terakhir
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C. Exponential Smoothing (ES)

Adalah suatu metode ramalan rata-rata bergerak yang melakukan
penimbangan terhadap data masa lalu dengan cara exponential. Pada metode ini
peramalan dilakukan dengan cara hasil ramalan periode terakhir ditambah porsi
perbedaan atau tingkat kesalahan antara permintaan nyata periode terakhir dan

peramalan periode terakhir.

Ft = {Ft_; +a(At_; — Ft_,)}
Dimana :
Ft  =ramalan untuk periode sekarang (1)
Ft — 1= ramalan untuk periode sebelumnya (t-1)
a = smoothing konstan (porsi perbedaan)

At -1 = permintaan nyata periode sebelumnya

2.3 Kesalahan Peramalan
Kesalahan peramalan mempunyai 2 unsur yang harus diperhatikan :

1. Perbedaan antara permintaan nyata dengan peramalan (error)
2. Arah kesalahan, yaitu apakah permintaan nyata berada di atas atau di bawah

ramalan

Ada suatu ukuran kesalahan yang umum digunakan yaitu Mean Absolute
Deviation (MAD), dimana ukuran ini mencari selisih antara permintaan nyata dan
ramalan dengan tingkat rata-rata kesalahan selama meramalkan adalah :

Dimana :

Y kesalahan
N—n

MAD = N = Jumlah data penjualan

n = Jumlah periode
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CONTOH SOAL

1. Berikut adalah data penjualan tiket konser Taylor Swift:

Bulan JAN

FEB | MAR | APR

MEI

JUN | JUL

AGT

Penjualan | 3100

3300 | 3500 | 3700

4100

4500 | 5100

5500

Tentukanlah:

a. Metode Moving Average (MA) 3 periode dan buat analisisnya!
b. Metode Weight Moving Average (WMA) 3 periode dimana W1 = 0,2 ; W2

= 0,3 dan W3 = 0,5 buatlah analisisnya!
c. Metode Exponential Smoothing (ES) dengan o =

analisisnya!

PENYELESAIAN
a. MA 3 periode

Bulan | Penjualan Perge;sﬁzggeMA 3 Ra(rlnzi)lan Error (e)
JAN 3100
FEB 3300
MAR 3500
APR 3700 (3100+3300+3500) : 3 3300 400
MEI 4100 (3300+3500+3700) : 3 3500 600
JUN 4500 (3500+3700+4100) : 3 | 3766,667 | 733,333
JUL 5100 (3700+4100+4500) : 3 4100 1000
AGT 5500 (4100+4500+5100) : 3 | 4566,67 933,333
SEP (4500+5100+5500) : 3 | 5033,333

3666,666

Y. kesalahan 3666,666
MAD = = =733,333

N—n

8-3
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Kisaran:
Ft - MAD < X <Ft+MAD
5033,333 — 733,333 < X <5033,333 + 733,333

4300 < X <5766,666

Analisis:
Jadi, bila menggunakan metode MA 3 periode diramalkan penjualan bulan
ke-9 sebanyak 5033,333 dengan kisaran penjualan 4300 sampai 5766,666.

b. WMA 3 periode dimana W1 =0,2W2=0,3W3=0,5

i . Ramalan | Error
Bulan |Penjualan| Pergerakan WMA 3 periode

(F©) (€)
JAN | 3100
FEB | 3300
MAR | 3500

APR 3700 |(0,2*3100)+(0,3*3300)+(0,5*3500)| 3360 340
MEI 4100 |(0,2*3300)+(0,3*3500)+(0,5*3700)| 3560 540
JUN 4500 |(0,2*3500)+(0,3*3700)+(0,5*4100)| 3860 640
JUL 5100 |(0,2*3700)+(0,3*4100)+(0,5*%4500)| 4220 880
AGT 5500 |(0,2*4100)+(0,3*4500)+(0,5%5100)| 4720 780
SEP (0,2*4500)+(0,3*5100)+(0,5*5500)| 5180

3180

2. kesalahan 3180
N-n  8-3

MAD =
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Kisaran:

Analisis:
Jadi, bila menggunakan metode WMA 3 periode dengan besar masing-
masing bobot W1 = 0,2 ; W2 = 0,3 ; W3 = 0,5 diramalkan penjualan bulan

Ft—MAD <X <Ft+MAD

5180 - 636 <X <5180 + 636

4544 <X <5816

ke-9 sebanyak 5180 dengan kisaran penjualan 4544 sampai 5816.

c. Metode ES dengan a. = 0,85

Bulan | Penjualan ES dengan a = 0,85 Ra(r:lglan Error (e)
JAN 3100

FEB 3300 3100 3100 200
MAR 3500 3100+0,85(3300-3100) 3270 230
APR 3700 3270+0,85(3500-3270) 3465,5 234,5
MEI 4100 3465,5+0,85(3700-3465,5) 3664,825 | 435,175
JUN 4500 3664,825+0,85(4100-3664,825) | 4034,724 | 465,276
JUL 5100 4034,724+0,85(4500-4034,724) | 4430,209 | 669,791
AGT 5500 4430,209 +0,85(5100-4430,209)| 4999,531 | 500,469
SEP 4999,531+0,85(5500-4999,531) | 5424,93

2735,211
Y kesalahan 2735,211
MAD = = = 390,744

N—n - 8-1
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Kisaran :

Ft—MAD <X <Ft+MAD

5424,93 — 390,744 < X <5424,93 + 390,744

5034,186 < X <5815,674

Analisis:

Jadi, bila menggunakan metode ES dengan a = 0,85 diramalkan penjualan

bulan ke-9 sebanyak 5424,93 dan dengan kisaran penjualan 5034,186 sampai
5815,674.

APLIKASI KE PROGRAM WINQSB
1. Buka Software WinQSB, pilih Forecasting

[ posBox 0.74, Cpu speed: max 100% cycles, Frameskip 0, Program: ...  —

2.

Nepv Problem
Problem

Exit
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3. Jenis peramalan yang akan kita gunakan adalah Time Series Forecasting, oleh
karena itu pilih Time Series Forecasting.
e Masukkan Problem Title (isikan nama anda)

e Time Unit (satuan waktu) isikan sesuai dengan soal

e Number of Time Unit (period) = 8 (karena data penjualan sebanyak 8 bulan

= Forecasting Problem Specification

@ Time Series Forecasting

O Regressional Forecasting

4. Masukkan data observasi.

#5500
Month Historical Data
1 3100
3300
3500
3700
4100
4500
5100
00

O | O] |3 N

5. Untuk memulai peramalan pilih menu Solve and Analyze -> Perform

Forecasting.

File Edit Format BNEELTF-GF R0

Perform Forecasting E
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6. Untuk

menghitung  dengan metode MA  (Moving

pilih Moving Average (MA), masukkan:

Average)

e Number of periods to forecast = 1 (jumlah periode yang akan diramalkan)

e Number of periods in average = 3 (pergerakannya)
Klik OK untuk melanjutkan

Forecasting Setup

Forecasting Method Method Parameters Search Criterion
O Simple average (SA) @ Assign values @© MAD O CFE
® Mqving average [(MA) O Search the best OMSE O MAPE
O Weighted moving average [(WMA)
O Moving average with linear trend (MAT) _
O Single exponential smoothing (SES) _
O Single exponential smoothing with trend (SEST) _
O Double exponential smoothing (DES) _
O Double exponential smoothing with trend (DEST)
O Adap! ] hing (AES)
O Linear regression with time (LR} _
O Holt:Winters Additive Algorithm (HWA) [

O Holt-Winters Multiplicative Algorithm (HWM) Specify Initial Seasonal Indices
Retain other method’s result Enter Search Domain

7. Hasil akhir (MAD = 733)

Forecast Result for Taylor Swift

MAPE (%) | Tracking | R-sqaure

09-17-2023 | Actual
Month Data Signal
1 3100;
2 3300
3 3500
4 3700 3300 400 400 400 160000 10.81081
5 4100 3500 600 1000 500 260000 12.72248
b 4500 3766.667 733.3333 1733.333 577.7778 3525925 13.91375
7 5100 4100 1000 2733.333 683.3333 514444 4 1533727
8 5500 4566.667 933.3335 3666.667 733.3334 585777.8 15.66376
9 5033.333
CFE 3666.667
MAD 733.3334
MSE 585777.8
MAPE 15.66376
Trk.Signal 5
R-sqaure 1
m=3

T oW N -

— | -
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8. Untuk menghitung dengan metode Weight Moving Average (WMA), pilih
Weight Moving Average (WMA).

e Number of periods to forecast = 1 (jumlah periode yang akan diramalkan)

o Number of periods in average = 3 (pergerakannya)
Klik OK untuk melanjutkan

Forecasting Setup

Forecasting Method Method Parameters [§ Search Criterion
O Simple average (SA) @ Assign values © MAD O/CFE
O Moving average (MA] O Search the best [l OMSE O MAPE
@ Weighted moving average (WMA)

O Moving average with linear trend (MAT)

O Single exponential smoothing (SES)
O Single exponential smoothing with trend (SEST)

[ GEREE
O Doubl I smoothing (DES) ‘ =
) Double exponential smoothing .
ot - R
i ]
[

O Double exponential smoothing with trend [DEST)
O Adaptive exponential smoothing (AES)
O Linear regression with time (LR)

O Holt-Winters Additive Algorithm (HWA)

v =
O Holt-Winters Multiplicative Algorithm (HWM) Enter Moving Average Weights
Retain other method's result Enter Search Domain

9. Untuk memasukkan weight (beban) pilih Enter Moving Average Weights
(urutkan weight berdasarkan yang terkecil terlebih dahulu).
e Periode 1=0.20
e Periode 2 =0.30
e Periode 3 =0.50
Klik OK untuk melanjutkan, tekan OK pada form Forecasting Setup

=] Weighted Moving Average

Seesns e s

mber (Early First)
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10. Hasil akhir dengan menggunakan MAD = 636.

Forecast Result for Taylor Swift
09-17-2023 | Actual | Forecast by | Forecast | CFE MAD MSE | MAPE (%) | Tracking | R-sqaure

Month Data 3-WMA Error Signal
1 3100:
2 3300
3 3500
4 3700 3360 340 340 340 115600 9.189189 1 1
5 4100 3560 540 880 440 203600 11.17996 2 1
6 4500 3860 640 1520 506.6667 272266.7 12.19405 3 1
7 5100 4220 880 2400 600 397800 13.45926 4 1
8 5500 4720 780 3180 636 439920 13.60377 5 1
9 5180
CFE 3180
MAD 636
MSE 439920
MAPE 13.60377
Trk.Signal 5
R-sqaure 1
m=3
W(1)=0.2
k W(2)=0.3
W(3)=0.5

11. Untuk menghitung dengan menggunakan metode Single Exponential

Smoothing, pilih Single Exponential Smoothing (SES).

e Number of periods to forecast = 1 (jumlah periode yang akan diramalkan).
e Smoothing constant alpha = 0.85
Klik OK untuk melanjutkan

Forecasting Setup

Forecasting Method Method Parameters Search Criterion |
O Simple average [SA) ® Assign values @ MAD OCFE
O Moving average (MA) O Search the best O MSE O'MAPE
O Weighted moving average [WHA)

O Moving average with linear trend [MAT) [Number of periods to forecastfly |
® Single exponential smoothing (SES) Smoothing constantalpha  Nogs |
O Single exponential smoothing with trend (SEST) initial value F(0] if ki _
O Doubfd exponential smoothing (DES)

O Double exponential smoothing with trend (DEST)

B
O Adapti p - hing (AES)
O Linear regression with time (LR) _
O Holt-Winters Additive Algorithm (HWA) Notaeedst

O Holt-Winters Multiplicative Algorithm (HWM) Enter Moving Average Weights
Retain other method's result Enter Search Domain

28| ManajemenOperasional



12. Hasil akhir Single Exponential Smoothing (SES) MAD = 390,744

Forecast Result for Taylor Swift

09-17-2023 | Actual | Forecast by | Forecast CFE MAD MSE MAPE (%) | Tracking | R-sqaure
Month SES Error Signal
1 ;
2 3300 3100 200 200 200 40000 6.060606 1 1
3 3500 3270 230 430 215 46450 6.316017 2 1
4 3700 34655 2345 664.5 221.5 49296.75 6.32329 3 1
5 4100 3664.825 435175 1099.675 274.9188 84316.89 7.395974 4 1
6 4500 4034.724 465.2764 1564.951 312.9903 110749.9 7.984674 5 1
i 5100 4430.208 669.7915 2234.743 372.4572 167061.7 8.842756 6 0.9024129
8 5500 4999.531 500.4688 2735.212 390.7445 178977 8.879424 7 0.9286489
9 5424.93
CFE 2735.212
MAD 390.7445
MSE 178977
MAPE 8.879424
Trk.Signal 7
R-sqaure 0.9286489
Alpha=0.85
F(0)=3100
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Soal Uji Kemampuan

1. Berikut adalah data penjualan tiket konser Coldplay 2023 :

Bulan JAN FEB | MAR | APR | MEI | JUN | JUL | AGT

Penjualan | 3000 | 3100 | 3500 | 4000 | 4200 | 4500 | 4800

5400

Tentukanlah:

a. Metode Moving Average (MA) 3 periode dan buat analisisnya!

b. Metode Weight Moving Average (WMA) 3 periode dimana W1 = 0,2 dan W>
= 0,3 dan W3 = 0,5 buatlah analisisnya!

c. Metode Exponential Smoothing (ES) dengan a = 0,60 dan buatlah

analisisnya!

2. Berikut adalah data penjualan tiket konser BlackPink 2022:

Bulan JAN | FEB | MAR | APR | MEI | JUN
Penjualan | 2100 | 2500 | 3000 | 3500 | 4250 | 4750

Tentukanlah:
a. Metode Moving Average (MA) 2 periode dan buat analisisnya!
b. Metode Weight Moving Average (WMA) 2 periode dimana W1 = 0,4 dan W>

= 0,6 buatlah analisisnya!
c. Metode Exponential Smoothing (ES) dengan B = 0,30 dan buatlah

analisisnya!
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3. Berikut adalah data penjualan tiket masuk Dufan 2023 :

Bulan JAN FEB MAR APR MEI JUN

JUL

Penjualan | 2500 2800 3100 3300 3500 4000

4200

Tentukanlah:

a. Metode Moving Average (MA) 3 periode dan buat analisisnya!

b. Metode Weight Moving Average (WMA) 3 periode dimana Wi = 0,2;
W = 0,3 dan W3= 0.5. Buatlah analisisnya!

c. Metode Exponensial Smoothing (ES) dengan o.= 0,80

dan buatlah analisisnya!
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BAB Il1
ANALISIS JARINGAN CPM TANPA PERCEPATAN

Deskripsi modul

Critical Path Method merupakan suatu metode yang dirancang untuk
mengoptimalkan biaya proyek dimana dapat ditentukan kapan pertukaran biaya
dan waktu harus dilakukan untuk memenuhi jadwal penyelesaian proyek dengan
biaya seminimal mungkin (T.Hani Handoko, 1993:40). Critical Path Method
dibagi menjadi dua bagian, yaitu Critical Path Method tanpa percepatan dan
Critical Path Method dengan percepatan. Pada bab ini akan dijelaskan Critical

Path Method tanpa percepatan.

Analisis jaringan merupakan suatu metode analisis yang mampu
memberikan informasi kepada manajemen agar dapat melakukan perencanaan
dan pengendalian suatu kegiatan produksi atau proyek yang akan dilaksanakan.
Konsep network mula-mula disusun oleh sebuah perusahaan jasa konsultan
manajemen Boaz, Allen, dan Hamilton yang disusun untuk perusahaan pesawat
terbang Lockheed. Kebutuhan penyusunan network ini dirasa penting karena
perlu adanya koordinasi dan pengurutan kegiatan-kegiatan pabrik yang
kompleks, saling berhubungan, dan saling tergantung satu sama lain. Analisis ini
digunakan untuk mengendalikan kegiatan-kegiatan yang bersifat tidak rutin, atau
terutama pada tipe proses produksi intermitten (produksi pesanan). Secara
umum, dapat dikatakan bahwa analisis jaringan digunakan untuk membantu

menyelesaikan masalah—masalah yang timbul dari serangkaian pekerjaan.

Masalah—masalah yang dimaksud antara lain adalah :

a.  Waktu penyelesaian yang berbeda—beda dari serangkaian pekerjaan tersebut.

b. Biaya yang harus dikeluarkan untuk melaksanakan serangkaian kegiatan
tersebut.

c. Waktu menganggur yang terjadi di setiap pekerjaan.
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Tujuan Pembelajaran

Setelah menyelesaikan praktikum pada modul ini, praktikan akan memahami:

e Membuat analisa tentang jalur Kritis.
e Dapat menentukan durasi penyelesaian suatu pekerjaan.
e Membandingkan durasi total pekerjaan dengan waktu yang dibutuhkan.

e Menetapkan perkiraan waktu atau biaya untuk setiap aktivitas, yang berguna
untuk menghemat waktu dalam pengerjaan proyek tersebut serta
meminimalisasi biaya dalam pengerjaan proyek.

e Menggunakan jaringan untuk membantu perencanaan, penjadwalan, dan

pengendalian proyek.

Isi

Pembelajaran : Menganalisis suatu proyek dengan menggunakan analisis
jaringan.

Latihan 1 : Menghitung waktu penyelesaian suatu proyek.

Latihan Soal

ARTI PENTING ANALISIS JARINGAN CPM TANPA PERCEPATAN
Metode Jaringan:

Begitu banyak perusahaan yang menggunakan konsep network (jaringan)
dalam perusahaannya sehingga menyebabkan banyak sekali muncul metode-
metode network baru yang berkembang atas dasar kebutuhan masing-masing
perusahaan dalam melaksanakan kegiatan usaha yang diterapkan oleh masing-

masing perusahaan. Namun, nama yang paling umum digunakan adalah:
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1. PERT (Program Evaluation and Review Technique)
PERT dikembangkan oleh Angkatan Laut Amerika dalam pengelolaan
program peluru kendali Polaris yang dirancang untuk membantu
scheduling (penjadwalan) agar perencanaan dan pengawasan semua kegiatan
dapat dilakukan secara sistematis sehingga efisiensi kerja dapat tercapai.

2. CPM (Critical Path Method)
CPM mengusahakan optimalisasi biaya total (Overhead and  Activity

Cost) untuk jangka waktu penyelesaian yang bisa dicapai.

3.1 Keuntungan Analisis Jaringan

Beberapa contoh serangkaian pekerjaan yang dapat diselesaikan dengan
analisis jaringan, antara lain:

a. Serangkaian pekerjaan membangun jembatan;

b. Serangkaian pekerjaan membangun gedung;

c. Serangkaian pekerjaan produksi;

d. Serangkaian pekerjaan mengganti mesin yang rusak, dll.

Dengan menggambarkan jaringan (diagram network) kegiatan proses

produksi, pihak manajemen akan memperolen manfaat, antara lain:

a. Memperoleh logika ketergantungan atau logika kegiatan proses produksi.
b. Dapat mengetahui bahaya akan keterlambatan dari proses produksi.

c. Dapat diketahui kemungkinan perubahan jalur kegiatan produksi yang
lebih baik atau lebih ekonomis.

d. Dapat dipelajari kemungkinan percepatan dari salah satu atau beberapa
jalur kegiatan.

e. Dapat diketahui batas waktu penyelesaian keseluruhan proses produksi.

35| ManajemenOperasional



3.2 Simbol-simbol Jaringan

Beberapa simbol yang digunakan adalah:

— Anak Panah, menunjukkan sebuah kegiatan (activity) yang harus
dilaksanakan dimana penyelesaian memerlukan waktu, biaya, dan
fasilitas tertentu.

Lingkaran, menunjukkan peristiwa atau kejadian (event) baik atas
dimulainya  suatu kegiatan, maupun kejadian atas

berakhirnya/selesainya suatu kegiatan.

———— Anak Panah Terputus, menunjukkan kegiatan semu (Dummy

Activity) atau garis semu.

3.2 Istilah-istilah Lain Dalam Network

1 Earliest Start Time (ES). yaitu waktu paling awal (tercepat) untuk dapat
memulai sesuatu kegiatan dengan waktu normal tanpa mengganggu kegiatan

lain dan dengan memperhatikan waktu kegiatan yang diharapkan dan

persyaratan urutan pekerjaan, dimana: ESy = EF;,_y,

2. Earliest Finish Time (EF). yaitu waktu paling awal (tercepat) untuk dapat
menyelesaikan suatu kegiatan dengan waktu normal tanpa mengganggu

kegiatan yang lain, dimana: EFy,, = ES(y,, + ETy,

3 Latest Finish Time (LE), vyaitu waktu paling lambat (akhir)

untuk menyelesaikan suatu kegiatan dengan waktu normal tanpa
mengganggu kelancaran kegiatan yang lain dan tanpa penundaan
penyelesaian proyek secara keseluruhan, dimana: LF, = EF~, bila yang
dihitung adalah kegiatan akhir (terminal event) atau LF, = LS,-n, bila yang

dihitung bukan terminal event.
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4. Latest Start Time (LS), yaitu waktu paling lambat (akhir) untuk dapat
memulaisuatu kegiatan dengan waktu normal tanpa mengganggu kelancaran
kegiatan lain dan tanpa penundaan keseluruhan proyek, dimana:
LSy = LF,, + ETy,

Keterangan:
n = Kkegiatan ke-n atau kegiatan yang sedang dianalisis

n-1 = kegiatan terakhir sebelum kegiatan ke-n

3.3 Beberapa Hal yang Perlu Diperhatikan Dalam Analisis jaringan

1 Sebelum suatu kegiatan dimulai, semua kegiatan yang mendahuluinya harus
sudah diselesaikan.

2. Gambar anak panah hanya sekedar menunjukkan urutan-urutan di dalam
mengerjakan pekerjaan. Panjang atau pendeknya anak panah dan arahnya
tidak menunjukkan lama atau singkatnya, serta letak dari pekerjaan.

3. Lingkaran (nodes) yang menunjukkan kegiatan diberi nomor sedemikian
rupa sehingga tidak terdapat lingkaran yang mempunyai nomor yang sama.

4. Dua buah kejadian (event) hanya dapat dihubungkan oleh satu kegiatan
(anak panah).

5 Network (jaringan) hanya dimulai dari satu kejadian (initial event) dan

diakhiri oleh satu kejadian akhir saja (Terminal Event).

Namun, seringkali suatu kasus jaringan dihadapkan pada kondisi
dimana point 4 dan 5 tidak dapat dihindari, sehingga untuk
mengatasinya harus dibuatkan atau dibantu dengan sebuah aktivitas
DUMMY.
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3.4 Dummy Activities

Dummy Activities atau kegiatan semu adalah kegiatan yang memakan waktu
relatif sangat singkat dengan biaya serta fasilitas yang sedikit bila dibandingkan
dengan kegiatan-kegiatan lainnya, sehingga kegiatan semu dianggap bukan
sebagai kegiatan biasa. Sifat-sifat kegiatan semu, antara lain:

1. Waktu relatif sangat pendek dibandingkan dengan kegiatan lainnya,
sehingga tidak memerlukan waktu.

2. Menentukan boleh tidaknya kegiatan selanjutnya dilakukan.

3. Dapat merubah jalur kritis dan waktu Kritis.

Manfaat atau kegunaan kegiatan semu, antara lain:

1. Untuk menghindari dua kejadian dihubungkan lebih dari satu kegiatan.

Dengan adanya aktivitas dummy akan menjadi seperti
O
2. Apabila ada dua kegiatan pada awal atau akhir kejadian, maka
diperlukan adanya penambahan suatu kegiatan semu pada suatu kegiatan

lainnya.

3. Untuk menunjukkan urutan kejadian atau kejadian yang sebenarnya
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3.5 Jalur Kritis (CRITICAL PATH)

Jalur kritis adalah jalur yang jumlah jangka waktu penyelesaian kegiatan-

kegiatannya terbesar atau terlama dan menjadi waktu penyelesaian minimum

yangdiharapkan. Suatu jalur kritis bisa didapatkan dengan menambah waktu

suatu aktivitas pada tiap urutan pekerjaan dan menetapkan jalur terpanjang pada

tiap proyek. Biasanya, sebuah jalur kritis terdiri dari pekerjaan-pekerjaan yang

tidak bisa ditunda waktu pengerjaannya.

Ciri-ciri jalur Kritis:

1)
2)

Jalur yang memakan waktu terpanjang dalam suatu proses.

Jalur yang tidak memiliki tenggang waktu antar waktu selesainya suatu
tahap kegiatan berikutnya.

Tidak adanya tenggang waktu tersebut yang merupakan sifat kritis dari
jalur kritis tersebut.

Manfaat analisa jalur kritis:

1)

2)
3)

4)

5)

Dapat diketahui rencana proyek secara terperinci sebelum proyek
dijalankan.

Dapat diketahui berapa lama proses produksi memakan waktu.

Dari jalur kritis pihak manajemen dapat mengetahui kegiatan-kegiatan mana
saja yang memerlukan pengendalian secara cermat.

Dari jalur yang bukan jalur kritis dapat diketahui besarnya idle
capacity (kapasitas menganggur), yaitu dengan melihat besar slack dan
floatnya.

Slack dan float merupakan perbedaan antara waktu paling cepat (earliest
time) dengan waktu yang paling lambat (latest time). Jadi slack dan float
merupakan perbedaan antara ES dan LS atau antara EF dan LF. Hanya saja
istilah slack digunakan dalam jaringan yang disusun berdasarkan kejadian,

sedangkan float digunakan dalam jaringan yang berdasarkan kegiatan.
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CONTOH SOAL

1. Universitas Gunadarma berencana untuk melakukan perluasan bangunan

dengan data sebagai berikut:

Kegiatan Kegiatan Sebelumnya | Waktu (Dalam Bulan)
A - 15
B 12
C A 11
D B,C 10
E D 11
F E 11
G F 12
H F 12
I G,H 11
Carilah:

a.  Gambar Jaringannya!
b. Tentukan Jalur Kritisnya dan Waktu Penyelesaiannyal

c. Analisis!

PENYELESAIAN

a. Gambar Jaringan

©
©

DI0 Ell Fl11
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b. Jalur Kritis dan Waktu Penyelesaiannya

A-B-Dum1l-D-E-F-G-Dum2-I

15+12+0+10+11+11+12+0+11=82

A-B-Dum1-D-E-F-H-I

15+12+0+10+11+11+12+11=82

A-C-D-E-F-G-Dum2-1

15+11+10+11+11+12+0+11=81

A-C-D-E-F-H-I

15+11+10+11+11+12+11=81

c. Analisis

Jadi, dari penyelesaian di atas dapat diketahui bahwa ditemukan dua hasil

perhitungan yang memiliki hasil yang sama pada waktu penyelesaiannya yaitu 82.
Dengan melalui jalur kritis A-B-Dum1-D-E-F-G-Dum2-I atau A-B-Dum1-D-E-

F-H-I.

Aplikasi Program DOSBox

1. Buka software DOSBox, START -> Ketik DOSBox pada kolom search ->
Klik kiri untuk membuka software DOSBox

£ §7] DOsBox0.74

o App
.—, Apps
El DOSBox 0.74 Options

Bl DOSBox 0.74 (noconsole)
[V [ Reset Options
=2 Reset KeyMapper

Bl Screenshots & Recordings
HEl Search the web
2 DOSBOX - See web results
g Documents

DOSBox 0.74 Manual

£ posBox
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2. Kemudian pilih PERT/CPM Untuk memulai perhitungan, pilih File -> New

Problem

E DOSBox 0.74, Cpu speed: max 10

Fi

MNew Problem
Load Problem

Exit

3. Untuk melakukan perhitungan, ikuti langkah berikut:
e Masukkan Problem Title (isikan nama perusahaan)
e Number of activities = 9 (banyaknya aktivitas)

e Time unit (satuan waktu) = month

Pilih hanya Normal Time nya saja pada bagian Select CPM Data
Field.Klik OK.

5Box 0.74, Cpu speed: max 100% cycles, Frameskip 0, Program: KRML326
PERT/CPM

Problem Type elect'CPM Data Field
< Normal Time
[ Crash Time
Mormal Cost
Cost

I~ Cra
T Actual Cost
T Percent Complete

Activity Time Distribution:
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4. Input data kegiatan sesuai dengan soal

ve and Analyze FHesults  Utilities Window WinQSB Help

wersitas Gunadarma

Activity Activity Immediate Predecessor [list Mormal

Mumber Mame number/name, separated by °.°] Time
1 Al % 15|
2 B A 12|
3 C A LA
4 D B.C 10
5 E D LA
[ F E 1
7 G F 12|
8 H F 12|
9 1 G.H 11

5. Untuk mendapatkan hasil, pilih menu Solve and Analyze -> Solve Critical
Path

1, Cpu speed: max 100% cycles, Frameskip 0, Program: KRNL326

Format BE{INVERETGEOEIELN Results Utilities  Window  WinQSB  Help

I Solve Critical Path
Ei Solve Critical Path U k g Crash Time

Perform Crashing Analysis

Perform Erobability Analy redecessor (list | Nomal

Perform Simulation [sepalaled by )| Time
1 A 15
2 B A 12
3 C A 11
4 D B.C 10
5 E D 1
6 F E 11
7 G F 12
8 H F 12
3 A T i

6. Hasil akhir Critical Path (lihat pada On Critical Path : Yes)Jalur  Kkritis:
A-B-Dummy1-D-E-F-G-Dummy2-1 dan A-B-Dummy1-D-E-F-H-1.
Waktu penyelesaian : 82 Bulan

Results

09-14-2023] Activity Activity | Earliest | Earliest| Latest | Latest| Slack
17:29:39 | Name th i Finish | Start | Finish | (LS-ES)
1 A Yes 15 ] 15 0 15 0
H B Yes 12 15 27 15 | 27 0
3 c no 1 15 26 16 | 27 1
1 D Yes 10 27 37 27 | 37 0
5 E Yes 1 37 48 37 | 48 0
5 F Yes 1 48 59 48 | 59 0
7 [ Yes 12 59 7 59 71 0
8 H Yes 12 59 7 59 71 0
9 1 Yes 1 kgl 82 7 82 0
Project | Completion Time - 82 | months

Number of _ Critical | Path(s] = 2
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7.  Gambar jalur kritis (jalur kritis yang berwarna merah)

File Results Utilities Window Help

E DOSBox 0.74, Cpu speed: max 100% cycles, Frameskip 0, Program: KRNL386
PERTICPM

=

[ 1

2

K]

Project Completion Time = 82 months L

PN
N

FAEELY
B

PN
E

PAEE:N
F

d
7

AN TR
1)
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Soal Uji Kemampuan

1. PT. MarkLee berencana membuat jalan penghubung antarara gudangdengan

kantor administrasi, dengan data sebagai berikut:

Kegiatan Kegiatan Sebelumnya | Waktu (Dalam Bulan)
A - 10
B A 12
C B
D B
E C.D 11
F E 13
G F 11
H G 10
I G 10
J H,I 8
K J 8
L K 13

Tentukanlah:
a. Gambar Jaringannya!
b. Tentukan Jalur Kritisnya dan Waktu Penyelesaiannya!

c. Buatlah analisisnya!
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2. PT. NANA berencana untuk melakukan perluasan bangunan dengan data
sebagai berikut:

Kegiatan Kegiatan Sebelumnya | Waktu (Dalam Bulan)
A - 8
B A 7
C A 13
D A 9
E B,C,.D 11
F E 7
G F 8
H G 13
I G 13
J H,I 6

Tentukanlah:
a. Gambar Jaringannya!
b. Tentukan Jalur Kritisnya dan Waktu Penyelesaiannya!

c. Buatlah Analisisnya
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3. Pemerintah berencana membuat LRT yang menghubungkan antara Stasiun

Pulomas dengan Stasiun Velodrome, dengan data sebagai berikut:

Kegiatan Kegiatan Sebelumnya Waktu (Dalam Bulan)
A - 10
B A 13
C A 8
D C 6
E C 11
F D,E 7
G F 10
H F 10
I G,H 5)
J B 12
K 1,J 5)

Tentukanlah:

a. Gambar Jaringannya!

b. Tentukan Jalur Kritisnya dan Waktu Penyelesaiannya!

c. Buatlah analisisnyal




Buku Seri Praktikum

Bab 4

ANALISIS JARINGAN
CPM DENGAN PERCEPATAN
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BAB IV
CPM (CRITICAL PATH METHOD) DENGAN PERCEPATAN

Deskripsi Modul

Analisis jaringan CPM (Critical Path Method) dengan percepatan
merupakan salah satu materi yang ada dalam Manajemen Operasional. Analisis
jaringan merupakan suatu metode analisis yang mampu memberikan informasi
kepada manajemen agar dapat melakukan perencanaan dan pengendalian suatu
kegiatan produksi atau proyek yang akan dilaksanakan. Pada pembahasan
modul ini kita memakai metode CPM (Critical Path Method), metode ini
mampu melakukan analisis terhadap sumber daya yang dipakai dalam proyek
(biaya) agar jadwal yang dihasilkan akan lebih optimal dan ekonomis. Lalu jika
kita ingin mempercepat proses pengerjaan suatu proyek, apa yang harus Kita

lakukan?

Tujuan Modul

Setelah menyelesaikan praktikum pada modul ini, praktikan akan memahami:
1. Proses perencanaan dan pelaksanaan suatu proyek.

2. Sistem kerja dari keseluruhan proses proyek yang dilakukan.

3. Pengidentifikasian dana tambahan yang diperlukan jika proyek

tersebut pengerjaannya dipercepat.

Isi
Pembelajaran : Menganalisis suatu proyek jika pengerjaannya dipercepat.

Latihan 1 : Menghitung biaya tambahan yang diperlukan.
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Arti Penting Analisis Jaringan CPM dengan Percepatan

Dalam suatu proyek yang dikehendaki selesai dalam jangka waktu yang
telah ditentukan, dapat dilakukan percepatan durasi kegiatan dengan konsekuensi
akan terjadi peningkatan biaya. Percepatan durasi pelaksanaan proyek dengan
biaya serendah mungkin dinamakan Crashing Project. Pada CPM, untuk
mempercepat waktu pengerjaan proyek maka diadakan percepatan durasi
kegiatan pada jalur-jalur kritis, dengan syarat bahwa pengurangan waktu tidak
akan menimbulkan jalur kritis baru. Salah satu cara untuk mempercepat waktu
pelaksanaan proyek di antaranya dengan menambah waktu kerja dengan tenaga
yang tersedia (kerja lembur). Penambahan jam kerja bisa dilakukan sesuai dengan
waktu penambahan yang diinginkan. Dengan adanya penambahan jam Kerja,
maka akan mengurangi produktivitas tenaga kerja, hal ini disebabkan karena

adanya faktor kelelahan oleh para pekerja.

4.1 Informasi yang dibutuhkan

1. Waktu Normal
Adalah waktu yang diperlukan bagi sebuah proyek untuk melakukan
rangkaian kegiatan sampai selesai tanpa ada pertimbangan terhadap
penggunaan sumber daya.

2. BiayaNormal
Adalah biaya langsung yang dikeluarkan selama penyelesaian kegiatan-
kegiatan proyek sesuai dengan waktu normalnya.

3. Waktu Dipercepat
Waktu dipercepat atau lebih dikenal dengan Crash Time adalah waktu paling
singkat untuk menyelesaikan seluruh kegiatan yang secara teknis
pelaksanaannya masih mungkin dilakukan. Dalam hal ini penggunaan

sumber daya bukan hambatan.
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4. Biaya untuk Waktu Dipercepat
Atau Crash Cost merupakan biaya langsung yang dikeluarkan untuk

menyelesaikan kegiatan dengan waktu yang dipercepat.

Biava
Biaya: B Tirik Dipercepet
untuk
waktu

A Titik Normal

- o = VWaktu
Waktu Waktu
Dipercenat Normal

Gambar 4.1 Hubungan antara waktu dan biaya pada keadaan normal dan

percepatan.

4.2 Biaya yang diperhitungkan

Dalam pengerjaan analisis metode CPM dengan percepatan ada biaya-biaya yang

harus diperhitungkan antara lain:

1. Biaya Kegunaan (Utility Cost) atau Opportunity Cost, yaitu biaya-biaya yang
berhubungan dengan waktu penyelesaian proyek berupa laba potensial yang
bisa diperoleh seandainya proyek bisa diselesaikan lebih cepat dan kerugian
potensial seandainya terjadi penundaan.

2. Biaya Tak Langsung (Indirect Cost), yaitu Biaya Overhead Pabrik (BOP),
sewa peralatan, gaji manajer yang naik, asuransi kekayaan, dan biaya

bunga yang naik dengan mundurnya penyelesaian proyek.

Biaya tambahan setiap kegiatan dapat dihitung dengan menggunakan rumus:

Biaya Percepatan — Biaya Normal

Bi Tambahan =
taya fambanan = v, rtu Normal — Waktu Percepatan
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Biaya percepatan dapat dihitung dengan menggunakan rumus:

Biaya Percepatan = Biaya Normal + {Biaya Tambahan(Waktu
Normal - Waktu Percepatan)}

Beberapa langkah pengerjaan metode CPM dengan percepatan:

1. Membuat gambar jaringan dari setiap kegiatan yang dilakukan.

2. Membuat jalur kritis dari gambar jaringan tersebut guna mencari waktu

terpanjang dari kegiatan te

rsebut.

3. Mencari biaya tambahan yang diperlukan jika mempercepat proses

pengerjaannya.

CONTOH SOAL

Tn. Gerrard sedang melakukan pembangunan stadion sepak bola, datanya.

Sebagai berikut:

Kegiatan Kegiatan Waktu Waktu Biaya Biaya
Sebelumnya | Normal |Percepatan| Normal | Percepatan
A - 10 5 1.200 1.400
B A 12 6 1.400 1.600
C A 8 4 1.000 1.200
D A 10 5 1.200 1.400
E B 14 7 1.600 1.800
F C 12 6 1.400 1.600
G CD 16 8 1.800 2.000
H F.G 18 9 2.000 2.200
| F.G 14 7 1.600 1.800
] H,I 18 9 2.000 2.200
K EJ 20 10 2.200 2.400
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Dari data di atas maka tentukanlah:

a) Buatlah Gambar Jaringannya!l

b) Buat Jalur Kritisnya!

¢) Jika Tn. Gerrard ingin mempercepat pembangunan stadion sepak bola
selamal0 bulan, maka berapa biaya tambahan yang diperlukan?

d) Buatlah analisisnya!

PENYELESAIAN
Langkah 1:

Menggambar jaringan dari proses kegiatan Tn. Gerrard.

Langkah 2:

Menentukan jalur kritis dari jaringan tersebut seperti berikut:

A-B-E-K 10+12+14+20 =56
A-C-F-H-DUM2-J-K 10+8+12+18+0+18+20 =86
A-C-DUM1-G-H-DUM2-J-K [10+8+0+16+18+0+18+20 =90
A-C-DUM1-G-1-J-K 10+8+0+16+14+18+20 =86
A-C-F-1-J-K 10+8+12+14+18+20 =82
A-D-G-H-DUM2-J-K 10+10+16+18+0+18+20 =92
A-D-G-1-J-K 10+10+16+14+18+20 =80
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Jadi, dari penyelesaian di atas dapat diketahui bahwa waktu penyelesaian yang
diperlukan oleh Tn. Gerrard untuk pembangunan stadion sepak bola yaitu 92
bulan. Dengan melalui jalur kritis A-D-G-H-DUM2-J-K

Biaya Normal Jalur Kritis

= A-D-G-H-DUM2-J-K.

(10*1.200) + (10*1.200) + (16*1.800) + (18*2.000) + (0*0) + (18*2.000) +
(20*2.200)

12.000+12.000+28.800+36.000+0+36.000+44.000 = 168.800

Langkah 3:
Menghitung berapa besar biaya tambahan yang dibutuhkan untuk proses

pengerjaan stadion sepak bola. Akan tetapi pada soal di atas, besar biaya
tambahannya belum diketahui, maka kita cari terlebih dahulu besar biaya

tambahannya, setelah itu baru menghitung biaya tambahan percepatannya.

Kegiatan Biaya Tambahan
A 40
33,33
50
40
28,57
33,33
25
22,22
I 28,57
22,22

T O MmO |
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Biaya Tambahan (10 Bulan percepatan)

A =5X40 =200
D =5X 40 =200
G =8X 25 =200 DUM2 =0X0 = 0
H =9 X 22,22 =199,98 K =10 X20 =200 +
DUM2 =0 X0 =0 200
J =9 X 2222 =199,98
K =10X 20 = 200
Langkah 4:

Menganalisa berapa besar biaya tambahan yang diperlukan dalam
mempercepat proses pengerjaan proyek tersebut.

e Lamanya Waktu =92 bulan

e Biaya Secara Normal =17.400

Jika dipercepat 10 bulan maka:
e Waktu Pengerjaan = 92 bulan — 10 bulan = 82 bulan
e Biaya Dipercepat = 17.400 + 200 =17.600

Langkah 5:

Kesimpulannya yaitu jika Tn. Gerrard ingin mempercepat pembangunan stadion sepak
bola selama 10 bulan, maka diperlukan biaya tambahan sebesar 200. Dengan jalur
kritis A-D-G-H-DUM2-J-K.
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Aplikasi: Metode CPM dengan Percepatan menggunakan software WINQSB

1. Buka software WinQSB, START => All Programs => WinQSB,
pilihnPERT_CPM.

|B DOSBox 0.74, Cpu speed: max 100% cycles, Frameskip 0, Program: .. —

=) Program Manager

File Options Window Help

Applications

IS

Linear and Goal Quadratic Nonlinear N
Integer Programming  Programming  Programming Modeling

Pru;ramming

o
Slas

Dynamic PERT/CPM Queuing Inventory
Programming Analysis System Theory and
Simulation System
nt E
A
Accessofies @ . . 1/‘ L
Material Forecasting Decision ov Quality Control
Requirements Analysis Process Chart
Planning
g Es
Acceptance  Agaregate Facility Job
Sampling Planning Locationand  Scheduling 3

2. Untuk memulai perhitungan pilih File => New Problem.

Help

Load*Problem

Exit
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3. Untuk melakukan perhitungan:

Problem title (isikan dengan nama anda)

Number of Activities = 11

Time Unit (satuan waktu) = month

Pilih Normal Time, Crash Time, Normal Cost dan Actual Cost

Klik ok untuk melanjutkan

elect CPM Data Field

o X Normal Time
@ Deterministic CPM (% Crash Time

O Probabilistic PERT [X Normal Cost

@® Spreadsheet
O Graphic Model

4. Masukkan data sesuai dengan yang ada pada soal.

Activity |  Activity Immediate Predecessor (list | Nommal | Crash Normal l Actual
Number Name number/name, separated by *.') [ Time Time Cost Cost
1 A 10 5 1200 1400
2 B A 12 [ 1400 1600
3 C A 8 4 1000 1200
4 D A 10 5 1200 1400
5 E B 14 7 1600 1800
b F [ 12 6 1400 1600
7 G C.D 16 8 1800 2000
8 H F.G 18 9 2000 2200
9 1 F.G 14 7 1600 1800
10 J H.I 18 9 2000 2200
11 K E.J 20 10 2200
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5. Pilih Solve and Analyze => Solve Critical Path Using Normal Time

untukmenghitung.

File Edit Format BELIFEETLE.OEFSE Results  Utilities

EEEE Solve Critical Paikh Using Normal Time

Solve Critical Pdata Using Crash Time

!

Immediate Predecess Eeﬁorm g’azhib“.?_ AlefiS-
BN | criorm mrahability Analysls
Number| Perform Simulation

6. Hasil akhir Critical Path (lihat pada On Critical Path: Yes).Jalur kritis: A-D
G-H-J-K.
e Waktu penyelesaian: 92 months.

e Biaya secara normal: 17.400.

Activity Analysis for Tn. Gerrard [Using Normal Time]

09-15-2023| Activity | On Critical | Activity | Earliest | Earliest | Latest |Latest| Slack
12:24:42 Name Path Time Start | Finish Start | Finish | (LS-ES)
1 A i Yes 10 0 10 0 10 0
2 B no 12 10 22 46 58 36
3 C no 8 10 18 12 20 2
4 D Yes 10 10 20 10 20 0
5 E no 14 22 36 58 72 36
6 F no 12 18 30 24 36 6
7 G Yes 16 20 36 20 36 0
8 H Yes 18 36 54 36 54 0
9 1 no 14 36 50 40 54 4
10 J Yes 18 54 72 54 72 1]
11 | K Yes 20 72 92 72 92 0
| Project Completion Time = 92 monts
Total Cost of  Project = $17.400 (Coston CP = $10.400)
T |Mumberof Ciitical Pathls) = 1

7. Untuk menghitung biaya tambahan dengan 10 bulan percepatan. Pilihmenu

Results => Project Completion Analysis.

Format BEGETIIEN Utilities Window Help
=l Activity Criticality Analysis
Graphic Activity Analysis

Show Critical Path

Gantt Chart
Project Completion Analysis

PERT{Cost -Table
PERT{Cost - Graphic
Project Cost Control Report

Perform Crashing Analysis
Show Crashing Result
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8. Input 10 bulan percepatan.
= Project Completion Analysis

[ Cunent proect tme in mont: 10—

9. Hasil akhir.

09-15-2023 | Activity | On Critical | Activity | Latest | Latest | Planned %
12:29:02 | Name Path Time | Start | Finish | Completion
1 A Yes 10 0 10 100
2 B no 12 46 58 0
3 C no 8 12 20 0
4 D Yes 10 10 20 0
5 E no 14 58 72 0
6 F no 12 24 36 0
7 G Yes 16 20 36 0
8 H Yes 18 36 54 0
9 | no 14 40 54 0
10 J Yes 18 54 72 0
1 K Yes 20 72 92 0
Overall Project: 0 92 10.8696
10. Gambar jalur kritis (jalur kritis berwarna merah).
File Results Utilities Window Help
= BH i s+ I
= Biata avd (D ata A :
K 1 2 Project Completion Time = 92 monts (Using Normal Time

Note
Waktu pengerjaan dan biaya dipercepat belum diketahui cara menampilkannya di

software, jadi hitung manual saja.
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Ujian Kemampuan
1. PT.INDRIYANTI sedang melakukan pembangunan cabang perusahaan baru di

daerah Jakarta, datanya sebagai berikut:

Kegiatan Kegiatan | Waktu Waktu Biaya Biaya
Sebelumnya | Normal | Percepatan | Normal | Perceapatan
A - 12 10 3.500 4.000
B A 8 6 1.200 1.300
C A 4 3 600 1.000
D A 2 500 750
E B,C,D 12 11 1.800 2.100
F E 18 15 2.200 2.600
G E 5 4 750 1.000
H F 8 6 1.200 1.300
I G 4 2 650 750
J H 6 4 900 1.000
K 1,J 8 6 1.200 1.300

Dari data diatas maka tentukanlah:

a. Buatlah gambar jaringannya!

b. Buatlah jalur kritisnya!

c. Jika PT.INDRIYANTI ingin mempercepat pembangunan Gedung selama 12
bulan, maka berapa biaya tambahan yang diperlukan?

d. Buatlah analisisnyal
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2. Tn. Qadafi sedang melalukan pembangunan stadion bulu tangkis, datanya

sebagai berikut :

Kegiatan Kegiatan | Waktu Waktu Biaya Biaya
Sebelumnya | Normal | Percepatan | Normal | Perceapatan
A - 10 8 2.000 3.000
B - 8 6 1.600 1.900
C A.B 4 3 800 950
D C 6 5 1.200 1.300
E C 12 10 2.400 2.500
F C 16 12 3.200 3.600
G E 5 4 1.000 1.200
H D,G 8 6 1.600 1.900
| H,F 4 3 800 950
J H,F 6 5 1.200 1.300
K 1,J 8 6 1.600 1.900

Dari data diatas maka tentukanlah:

a. Buatlah gambar jaringannya!

b. Buatlah jalur kritisnyal

c. Jika Tn. Qaadafi ingin mempercepat pembangunan Stadion bulu tangkis

selama 15 bulan, maka berapa biaya tambahan yang diperlukan?

d. Buatlah analisisnya
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3. PT. RADIT sedang melakukan pembangunan perumahan, datanya sebagai

berikut :
Kegiatan Kegiatan | Waktu Waktu Biaya Biaya
Sebelumnya | Normal | Percepatan | Normal | Perceapatan
A - 4 2 1.400 1.500
B - 7 6 2.400 2.700
C AB 6 4 2.200 2.300
D C 7 6 2.400 2.700
E C 9 8 1.800 2.800
F C 5 3 2.000 2.150
G D 5 3 2.000 2.150
H E 8 6 2.600 2.700
| F 4 2 1.400 1.500
J G,H,I 7 6 2.400 2.700

Dari data diatas maka tentukanlah:

a. Buatlah gambar jaringannya!

b. Buatlah jalur kritisnyal
c. Jika PT. RADIT ingin mempercepat pembangunan perumahan selama 18

bulan, maka berapa biaya tambahan yang diperlukan?

d. Buatlah analisisnya!
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Pada bab 1, kita akan membahas mengenai MANUFACTURING RESOURCE
PLANNING atau yang biasa disebut MRP. MRP adalah suatu teknik yang
digunakan untuk perencanaan dan pengendalian item barang (komponen) yang
tergantung (dependent) pada item ditingkat (level) yang lebih tinggi. MRP sendiri
digunakan untuk membantu perusahaan dalam mengatasi kebutuhan komponen
minimum dari komponen yang kebutuhannya dependen serta menjamin

tercapainya produksi akhir.

Lalu pada bab 2, kita akan membahas FORECASTING. Peramalan dapat
diartikan sebagai seni dan ilmu untuk memperkirakan kejadian di masa depan.
Metode peramalan akan membantu dalam mengadakan pendekatan analisa
terhadap tingkah laku atau pola dari data yang lalu, sehingga dapat memberikan
cara pemikiran, pengerjaan dan pemecahan yang sistematis dan pragmatis, serta
memberikan tingkat keyakinan yang lebih besar atas ketepatan hasil ramalan yang
dibuat.

Pada bab 3 dan bab 4 kita akan mempelajari ANALISIS JARINGAN CPM
TANPA PERCEPATAN dan ANALISIS JARINGAN CPM DENGAN
PERCEPATAN. Kedua bab ini adalah metode yang dirancang untuk
mengoptimalkan biaya proyek dimana dapat ditentukan kapan pertukaran biaya
dan waktu harus dilakukan untuk memenuhi jadwal penyelesaian proyek dengan

biaya seminimal mungkin (T.Hani Handoko, 1993:40).

Dalam Modul Manajemen Operasional yang dipelajari, akan dijelaskan
bagaimana cara melakukan penyelesaian kasus yang dapat praktikan kerjakan

melalui software. Software yang digunakan dalam modul ini ialah WINQSB.




